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Basic Safety Instructions 
Always read through and comply with the following safety instructions! 

All plants and locations of the Rohde & Schwarz group of companies make every effort to keep the safety 
standards of our products up to date and to offer our customers the highest possible degree of safety. Our 
products and the auxiliary equipment they require are designed, built and tested in accordance with the 
safety standards that apply in each case. Compliance with these standards is continuously monitored by 
our quality assurance system. The product described here has been designed, built and tested in 
accordance with the attached EC Certificate of Conformity and has left the manufacturer’s plant in a 
condition fully complying with safety standards. To maintain this condition and to ensure safe operation, 
you must observe all instructions and warnings provided in this manual. If you have any questions 
regarding these safety instructions, the Rohde & Schwarz group of companies will be happy to answer 
them. 

Furthermore, it is your responsibility to use the product in an appropriate manner. This product is designed 
for use solely in industrial and laboratory environments or, if expressly permitted, also in the field and must 
not be used in any way that may cause personal injury or property damage. You are responsible if the 
product is used for any purpose other than its designated purpose or in disregard of the manufacturer's 
instructions. The manufacturer shall assume no responsibility for such use of the product.  

The product is used for its designated purpose if it is used in accordance with its product documentation 
and within its performance limits (see data sheet, documentation, the following safety instructions). Using 
the product requires technical skills and, in some cases, a basic knowledge of English. It is therefore 
essential that only skilled and specialized staff or thoroughly trained personnel with the required skills be 
allowed to use the product. If personal safety gear is required for using Rohde & Schwarz products, this 
will be indicated at the appropriate place in the product documentation. Keep the basic safety instructions 
and the product documentation in a safe place and pass them on to the subsequent users. 

Observing the safety instructions will help prevent personal injury or damage of any kind caused by 
dangerous situations. Therefore, carefully read through and adhere to the following safety instructions 
before and when using the product. It is also absolutely essential to observe the additional safety 
instructions on personal safety, for example, that appear in relevant parts of the product documentation. In 
these safety instructions, the word "product" refers to all merchandise sold and distributed by the Rohde & 
Schwarz group of companies, including instruments, systems and all accessories. For product-specific 
information, see the data sheet and the product documentation. 

Symbols and safety labels 

Symbol Meaning Symbol Meaning 

Notice, general danger location 

Observe product documentation 

ON/OFF supply voltage 

Caution when handling heavy equipment Standby indication 

Danger of electric shock Direct current (DC) 
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Symbol Meaning Symbol Meaning 

Warning! Hot surface Alternating current (AC) 

Protective conductor terminal Direct/alternating current (DC/AC) 

Ground Device fully protected by double (reinforced) 
insulation 

Ground terminal EU labeling for batteries and accumulators 

For additional information, see section "Waste 
disposal/Environmental protection", item 1. 

Be careful when handling electrostatic sensitive 
devices 

EU labeling for separate collection of electrical 
and electronic devices 

For additonal information, see section "Waste 
disposal/Environmental protection", item 2. 

Warning! Laser radiation 

For additional information, see section 
"Operation", item 7. 

 

Signal words and their meaning 

The following signal words are used in the product documentation in order to warn the reader about risks 
and dangers. 

Indicates an imminently hazardous situation which, if not avoided, will result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in death or serious injury. 

Indicates a potentially hazardous situation which, if not avoided, could result 
in minor or moderate injury. 

Indicates the possibility of incorrect operation which can result in damage to 
the product.  
In the product documentation, the word ATTENTION is used synonymously.  

 
These signal words are in accordance with the standard definition for civil applications in the European 
Economic Area. Definitions that deviate from the standard definition may also exist in other economic 
areas or military applications. It is therefore essential to make sure that the signal words described here 
are always used only in connection with the related product documentation and the related product. The 
use of signal words in connection with unrelated products or documentation can result in misinterpretation 
and in personal injury or material damage. 
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Operating states and operating positions 

The product may be operated only under the operating conditions and in the positions specified by the 
manufacturer, without the product's ventilation being obstructed. If the manufacturer's specifications are 
not observed, this can result in electric shock, fire and/or serious personal injury or death. Applicable local 
or national safety regulations and rules for the prevention of accidents must be observed in all work 
performed.  

1. Unless otherwise specified, the following requirements apply to Rohde & Schwarz products:  
predefined operating position is always with the housing floor facing down, IP protection 2X, use only 
indoors, max. operating altitude 2000 m above sea level, max. transport altitude 4500 m above sea 
level. A tolerance of ±10 % shall apply to the nominal voltage and ±5 % to the nominal frequency, 
overvoltage category 2, pollution severity 2. 

2. Do not place the product on surfaces, vehicles, cabinets or tables that for reasons of weight or stability 
are unsuitable for this purpose. Always follow the manufacturer's installation instructions when 
installing the product and fastening it to objects or structures (e.g. walls and shelves). An installation 
that is not carried out as described in the product documentation could result in personal injury or 
even death. 

3. Do not place the product on heat-generating devices such as radiators or fan heaters. The ambient 
temperature must not exceed the maximum temperature specified in the product documentation or in 
the data sheet. Product overheating can cause electric shock, fire and/or serious personal injury or 
even death. 

Electrical safety 

If the information on electrical safety is not observed either at all or to the extent necessary, electric shock, 
fire and/or serious personal injury or death may occur.  

1. Prior to switching on the product, always ensure that the nominal voltage setting on the product 
matches the nominal voltage of the AC supply network. If a different voltage is to be set, the power 
fuse of the product may have to be changed accordingly.  

2. In the case of products of safety class I with movable power cord and connector, operation is 
permitted only on sockets with a protective conductor contact and protective conductor. 

3. Intentionally breaking the protective conductor either in the feed line or in the product itself is not 
permitted. Doing so can result in the danger of an electric shock from the product. If extension cords 
or connector strips are implemented, they must be checked on a regular basis to ensure that they are 
safe to use. 

4. If there is no power switch for disconnecting the product from the AC supply network, or if the power 
switch is not suitable for this purpose, use the plug of the connecting cable to disconnect the product 
from the AC supply network. In such cases, always ensure that the power plug is easily reachable and 
accessible at all times. For example, if the power plug is the disconnecting device, the length of the 
connecting cable must not exceed 3 m. Functional or electronic switches are not suitable for providing 
disconnection from the AC supply network. If products without power switches are integrated into 
racks or systems, the disconnecting device must be provided at the system level. 

5. Never use the product if the power cable is damaged. Check the power cables on a regular basis to 
ensure that they are in proper operating condition. By taking appropriate safety measures and 
carefully laying the power cable, ensure that the cable cannot be damaged and that no one can be 
hurt by, for example, tripping over the cable or suffering an electric shock.  
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6. The product may be operated only from TN/TT supply networks fuse-protected with max. 16 A (higher 
fuse only after consulting with the Rohde & Schwarz group of companies). 

7. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly and all the way into the 
socket provided for this purpose. Otherwise, sparks that result in fire and/or injuries may occur.  

8. Do not overload any sockets, extension cords or connector strips; doing so can cause fire or electric 
shocks. 

9. For measurements in circuits with voltages Vrms > 30 V, suitable measures (e.g. appropriate 
measuring equipment, fuse protection, current limiting, electrical separation, insulation) should be 
taken to avoid any hazards. 

10. Ensure that the connections with information technology equipment, e.g. PCs or other industrial 
computers, comply with the IEC60950-1/EN60950-1 or IEC61010-1/EN 61010-1 standards that apply 
in each case. 

11. Unless expressly permitted, never remove the cover or any part of the housing while the product is in 
operation. Doing so will expose circuits and components and can lead to injuries, fire or damage to the 
product. 

12. If a product is to be permanently installed, the connection between the protective conductor terminal 
on site and the product's protective conductor must be made first before any other connection is 
made. The product may be installed and connected only by a licensed electrician. 

13. For permanently installed equipment without built-in fuses, circuit breakers or similar protective 
devices, the supply circuit must be fuse-protected in such a way that anyone who has access to the 
product, as well as the product itself, is adequately protected from injury or damage. 

14. Use suitable overvoltage protection to ensure that no overvoltage (such as that caused by a bolt of 
lightning) can reach the product. Otherwise, the person operating the product will be exposed to the 
danger of an electric shock. 

15. Any object that is not designed to be placed in the openings of the housing must not be used for this 
purpose. Doing so can cause short circuits inside the product and/or electric shocks, fire or injuries. 

16. Unless specified otherwise, products are not liquid-proof (see also section "Operating states and 
operating positions", item 1). Therefore, the equipment must be protected against penetration by 
liquids. If the necessary precautions are not taken, the user may suffer electric shock or the product 
itself may be damaged, which can also lead to personal injury. 

17. Never use the product under conditions in which condensation has formed or can form in or on the 
product, e.g. if the product has been moved from a cold to a warm environment. Penetration by water 
increases the risk of electric shock. 

18. Prior to cleaning the product, disconnect it completely from the power supply (e.g. AC supply network 
or battery). Use a soft, non-linting cloth to clean the product. Never use chemical cleaning agents such 
as alcohol, acetone or diluents for cellulose lacquers. 

Operation 

1. Operating the products requires special training and intense concentration. Make sure that persons 
who use the products are physically, mentally and emotionally fit enough to do so; otherwise, injuries 
or material damage may occur. It is the responsibility of the employer/operator to select suitable 
personnel for operating the products. 
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2. Before you move or transport the product, read and observe the section titled "Transport". 

3. As with all industrially manufactured goods, the use of substances that induce an allergic reaction 
(allergens) such as nickel cannot be generally excluded. If you develop an allergic reaction (such as a 
skin rash, frequent sneezing, red eyes or respiratory difficulties) when using a Rohde & Schwarz 
product, consult a physician immediately to determine the cause and to prevent health problems or 
stress.  

4. Before you start processing the product mechanically and/or thermally, or before you take it apart, be 
sure to read and pay special attention to the section titled "Waste disposal/Environmental protection", 
item 1. 

5. Depending on the function, certain products such as RF radio equipment can produce an elevated 
level of electromagnetic radiation. Considering that unborn babies require increased protection, 
pregnant women must be protected by appropriate measures. Persons with pacemakers may also be 
exposed to risks from electromagnetic radiation. The employer/operator must evaluate workplaces 
where there is a special risk of exposure to radiation and, if necessary, take measures to avert the 
potential danger. 

6. Should a fire occur, the product may release hazardous substances (gases, fluids, etc.) that can 
cause health problems. Therefore, suitable measures must be taken, e.g. protective masks and 
protective clothing must be worn. 

7. Laser products are given warning labels that are standardized according to their laser class. Lasers 
can cause biological harm due to the properties of their radiation and due to their extremely 
concentrated electromagnetic power. If a laser product (e.g. a CD/DVD drive) is integrated into a 
Rohde & Schwarz product, absolutely no other settings or functions may be used as described in the 
product documentation. The objective is to prevent personal injury (e.g. due to laser beams). 

8. EMC classes (in line with CISPR 11) 
Class A: Equipment suitable for use in all environments except residential environments and 
environments that are directly connected to a low-voltage supply network that supplies residential 
buildings. 
Class B: Equipment suitable for use in residential environments and environments that are directly 
connected to a low-voltage supply network that supplies residential buildings. 

Repair and service 

1. The product may be opened only by authorized, specially trained personnel. Before any work is 
performed on the product or before the product is opened, it must be disconnected from the AC supply 
network. Otherwise, personnel will be exposed to the risk of an electric shock.  

2. Adjustments, replacement of parts, maintenance and repair may be performed only by electrical 
experts authorized by Rohde & Schwarz. Only original parts may be used for replacing parts relevant 
to safety (e.g. power switches, power transformers, fuses). A safety test must always be performed 
after parts relevant to safety have been replaced (visual inspection, protective conductor test, 
insulation resistance measurement, leakage current measurement, functional test). This helps ensure 
the continued safety of the product.  
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Batteries and rechargeable batteries/cells 

If the information regarding batteries and rechargeable batteries/cells is not observed either at all or to the 
extent necessary, product users may be exposed to the risk of explosions, fire and/or serious personal 
injury, and, in some cases, death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. 
lithium cells) must be handled in accordance with the EN 62133 standard. 

1. Cells must not be taken apart or crushed.  

2. Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight must be avoided. 
Keep cells and batteries clean and dry. Clean soiled connectors using a dry, clean cloth. 

3. Cells or batteries must not be short-circuited. Cells or batteries must not be stored in a box or in a 
drawer where they can short-circuit each other, or where they can be short-circuited by other 
conductive materials. Cells and batteries must not be removed from their original packaging until they 
are ready to be used. 

4. Cells and batteries must not be exposed to any mechanical shocks that are stronger than permitted. 

5. If a cell develops a leak, the fluid must not be allowed to come into contact with the skin or eyes. If 
contact occurs, wash the affected area with plenty of water and seek medical aid. 

6. Improperly replacing or charging cells or batteries that contain alkaline electrolytes (e.g. lithium cells) 
can cause explosions. Replace cells or batteries only with the matching Rohde & Schwarz type (see 
parts list) in order to ensure the safety of the product.  

7. Cells and batteries must be recycled and kept separate from residual waste. Rechargeable batteries 
and normal batteries that contain lead, mercury or cadmium are hazardous waste. Observe the 
national regulations regarding waste disposal and recycling.  

Transport 

1. The product may be very heavy. Therefore, the product must be handled with care. In some cases, 
the user may require a suitable means of lifting or moving the product (e.g. with a lift-truck) to avoid 
back or other physical injuries.  

2. Handles on the products are designed exclusively to enable personnel to transport the product. It is 
therefore not permissible to use handles to fasten the product to or on transport equipment such as 
cranes, fork lifts, wagons, etc. The user is responsible for securely fastening the products to or on the 
means of transport or lifting. Observe the safety regulations of the manufacturer of the means of 
transport or lifting. Noncompliance can result in personal injury or material damage. 

3. If you use the product in a vehicle, it is the sole responsibility of the driver to drive the vehicle safely 
and properly. The manufacturer assumes no responsibility for accidents or collisions. Never use the 
product in a moving vehicle if doing so could distract the driver of the vehicle. Adequately secure the 
product in the vehicle to prevent injuries or other damage in the event of an accident.  

Waste disposal/Environmental protection 

1. Specially marked equipment has a battery or accumulator that must not be disposed of with unsorted 
municipal waste, but must be collected separately. It may only be disposed of at a suitable collection 
point or via a Rohde & Schwarz customer service center. 
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2. Waste electrical and electronic equipment must not be disposed of with unsorted municipal waste, but 
must be collected separately. 
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and takes full responsibility for 
take-back obligations and disposal obligations for manufacturers within the EU. Contact your 
Rohde & Schwarz customer service center for environmentally responsible disposal of the product. 

3. If products or their components are mechanically and/or thermally processed in a manner that goes 
beyond their intended use, hazardous substances (heavy-metal dust such as lead, beryllium, nickel) 
may be released. For this reason, the product may only be disassembled by specially trained 
personnel. Improper disassembly may be hazardous to your health. National waste disposal 
regulations must be observed.  

4. If handling the product releases hazardous substances or fuels that must be disposed of in a special 
way, e.g. coolants or engine oils that must be replenished regularly, the safety instructions of the 
manufacturer of the hazardous substances or fuels and the applicable regional waste disposal 
regulations must be observed. Also observe the relevant safety instructions in the product 
documentation. The improper disposal of hazardous substances or fuels can cause health problems 
and lead to environmental damage. 

For additional information about environmental protection, visit the Rohde & Schwarz website. 

Instrucciones de seguridad elementales 
¡Es imprescindible leer y cumplir las siguientes instrucciones e informaciones de seguridad! 

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros productos siempre al día 
con los estándares de seguridad y de ofrecer a nuestros clientes el máximo grado de seguridad. Nuestros 
productos y todos los equipos adicionales son siempre fabricados y examinados según las normas de 
seguridad vigentes. Nuestro sistema de garantía de calidad controla constantemente que sean cumplidas 
estas normas. El presente producto ha sido fabricado y examinado según el certificado de conformidad 
adjunto de la UE y ha salido de nuestra planta en estado impecable según los estándares técnicos de 
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre de peligros, el usuario 
deberá atenerse a todas las indicaciones, informaciones de seguridad y notas de alerta. El grupo de 
empresas Rohde & Schwarz está siempre a su disposición en caso de que tengan preguntas referentes a 
estas informaciones de seguridad. 

Además queda en la responsabilidad del usuario utilizar el producto en la forma debida. Este producto 
está destinado exclusivamente al uso en la industria y el laboratorio o, si ha sido expresamente 
autorizado, para aplicaciones de campo y de ninguna manera deberá ser utilizado de modo que alguna 
persona/cosa pueda sufrir daño. El uso del producto fuera de sus fines definidos o sin tener en cuenta las 
instrucciones del fabricante queda en la responsabilidad del usuario. El fabricante no se hace en ninguna 
forma responsable de consecuencias a causa del mal uso del producto.  
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Se parte del uso correcto del producto para los fines definidos si el producto es utilizado conforme a las 
indicaciones de la correspondiente documentación del producto y dentro del margen de rendimiento 
definido (ver hoja de datos, documentación, informaciones de seguridad que siguen). El uso del producto 
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma inglés. Por eso se debe tener 
en cuenta que el producto solo pueda ser operado por personal especializado o personas instruidas en 
profundidad con las capacidades correspondientes. Si fuera necesaria indumentaria de seguridad para el 
uso de productos de Rohde & Schwarz, encontraría la información debida en la documentación del 
producto en el capítulo correspondiente. Guarde bien las informaciones de seguridad elementales, así 
como la documentación del producto, y entréguelas a usuarios posteriores. 

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible lesiones o daños por 
peligros de toda clase. Por eso es imprescindible leer detalladamente y comprender por completo las 
siguientes informaciones de seguridad antes de usar el producto, y respetarlas durante el uso del 
producto. Deberán tenerse en cuenta todas las demás informaciones de seguridad, como p. ej. las 
referentes a la protección de personas, que encontrarán en el capítulo correspondiente de la 
documentación del producto y que también son de obligado cumplimiento. En las presentes 
informaciones de seguridad se recogen todos los objetos que distribuye el grupo de empresas 
Rohde & Schwarz bajo la denominación de "producto", entre ellos también aparatos, instalaciones así 
como toda clase de accesorios. Los datos específicos del producto figuran en la hoja de datos y en la 
documentación del producto. 

Símbolos y definiciones de seguridad 

Símbolo Significado Símbolo Significado 

Aviso: punto de peligro general 

Observar la documentación del producto 

Tensión de alimentación de PUESTA EN 
MARCHA / PARADA 

Atención en el manejo de dispositivos de peso 
elevado 

Indicación de estado de espera (standby) 

Peligro de choque eléctrico Corriente continua (DC) 

Advertencia: superficie caliente Corriente alterna (AC) 

Conexión a conductor de protección Corriente continua / Corriente alterna (DC/AC) 

Conexión a tierra El aparato está protegido en su totalidad por un 
aislamiento doble (reforzado) 

Conexión a masa Distintivo de la UE para baterías y 
acumuladores 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 1. 
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Símbolo Significado Símbolo Significado 

Aviso: Cuidado en el manejo de dispositivos 
sensibles a la electrostática (ESD) 

Distintivo de la UE para la eliminación por 
separado de dispositivos eléctricos y 
electrónicos 

Más información en la sección 
"Eliminación/protección del medio ambiente", 
punto 2. 

Advertencia: rayo láser 

Más información en la sección 
"Funcionamiento", punto 7. 

 

Palabras de señal y su significado 

En la documentación del producto se utilizan las siguientes palabras de señal con el fin de advertir contra 
riesgos y peligros. 

PELIGRO identifica un peligro inminente con riesgo elevado que 
provocará muerte o lesiones graves si no se evita.  

ADVERTENCIA identifica un posible peligro con riesgo medio de 
provocar muerte o lesiones (graves) si no se evita. 

ATENCIÓN identifica un peligro con riesgo reducido de provocar 
lesiones leves o moderadas si no se evita. 

AVISO indica la posibilidad de utilizar mal el producto y, como 
consecuencia, dañarlo. 
En la documentación del producto se emplea de forma sinónima el 
término CUIDADO. 

 
Las palabras de señal corresponden a la definición habitual para aplicaciones civiles en el área 
económica europea. Pueden existir definiciones diferentes a esta definición en otras áreas económicas o 
en aplicaciones militares. Por eso se deberá tener en cuenta que las palabras de señal aquí descritas 
sean utilizadas siempre solamente en combinación con la correspondiente documentación del producto y 
solamente en combinación con el producto correspondiente. La utilización de las palabras de señal en 
combinación con productos o documentaciones que no les correspondan puede llevar a interpretaciones 
equivocadas y tener por consecuencia daños en personas u objetos. 

Estados operativos y posiciones de funcionamiento 

El producto solamente debe ser utilizado según lo indicado por el fabricante respecto a los estados 
operativos y posiciones de funcionamiento sin que se obstruya la ventilación. Si no se siguen las 
indicaciones del fabricante, pueden producirse choques eléctricos, incendios y/o lesiones graves con 
posible consecuencia de muerte. En todos los trabajos deberán ser tenidas en cuenta las normas 
nacionales y locales de seguridad del trabajo y de prevención de accidentes.  
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1. Si no se convino de otra manera, es para los productos Rohde & Schwarz válido lo que sigue:  
como posición de funcionamiento se define por principio la posición con el suelo de la caja para 
abajo, modo de protección IP 2X, uso solamente en estancias interiores, utilización hasta 2000 m 
sobre el nivel del mar, transporte hasta 4500 m sobre el nivel del mar. Se aplicará una tolerancia de 
±10 % sobre el voltaje nominal y de ±5 % sobre la frecuencia nominal. Categoría de sobrecarga 
eléctrica 2, índice de suciedad 2.  

2. No sitúe el producto encima de superficies, vehículos, estantes o mesas, que por sus características 
de peso o de estabilidad no sean aptos para él. Siga siempre las instrucciones de instalación del 
fabricante cuando instale y asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si 
se realiza la instalación de modo distinto al indicado en la documentación del producto, se pueden 
causar lesiones o, en determinadas circunstancias, incluso la muerte. 

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o calefactores). La 
temperatura ambiente no debe superar la temperatura máxima especificada en la documentación del 
producto o en la hoja de datos. En caso de sobrecalentamiento del producto, pueden producirse 
choques eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte. 

Seguridad eléctrica 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante en cuanto a seguridad 
eléctrica, pueden producirse choques eléctricos, incendios y/o lesiones graves con posible consecuencia 
de muerte.  

1. Antes de la puesta en marcha del producto se deberá comprobar siempre que la tensión 
preseleccionada en el producto coincida con la de la red de alimentación eléctrica. Si es necesario 
modificar el ajuste de tensión, también se deberán cambiar en caso dado los fusibles 
correspondientes del producto.  

2. Los productos de la clase de protección I con alimentación móvil y enchufe individual solamente 
podrán enchufarse a tomas de corriente con contacto de seguridad y con conductor de protección 
conectado. 

3. Queda prohibida la interrupción intencionada del conductor de protección, tanto en la toma de 
corriente como en el mismo producto. La interrupción puede tener como consecuencia el riesgo de 
que el producto sea fuente de choques eléctricos. Si se utilizan cables alargadores o regletas de 
enchufe, deberá garantizarse la realización de un examen regular de los mismos en cuanto a su 
estado técnico de seguridad. 

4. Si el producto no está equipado con un interruptor para desconectarlo de la red, o bien si el 
interruptor existente no resulta apropiado para la desconexión de la red, el enchufe del cable de 
conexión se deberá considerar como un dispositivo de desconexión.  
El dispositivo de desconexión se debe poder alcanzar fácilmente y debe estar siempre bien accesible. 
Si, p. ej., el enchufe de conexión a la red es el dispositivo de desconexión, la longitud del cable de 
conexión no debe superar 3 m).  
Los interruptores selectores o electrónicos no son aptos para el corte de la red eléctrica. Si se 
integran productos sin interruptor en bastidores o instalaciones, se deberá colocar el interruptor en el 
nivel de la instalación. 

5. No utilice nunca el producto si está dañado el cable de conexión a red. Compruebe regularmente el 
correcto estado de los cables de conexión a red. Asegúrese, mediante las medidas de protección y 
de instalación adecuadas, de que el cable de conexión a red no pueda ser dañado o de que nadie 
pueda ser dañado por él, p. ej. al tropezar o por un choque eléctrico.  
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6. Solamente está permitido el funcionamiento en redes de alimentación TN/TT aseguradas con fusibles 
de 16 A como máximo (utilización de fusibles de mayor amperaje solo previa consulta con el grupo de 
empresas Rohde & Schwarz). 

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo. Introduzca el enchufe por 
completo y fuertemente en la toma de corriente. La no observación de estas medidas puede provocar 
chispas, fuego y/o lesiones. 

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas de enchufe ya que esto 
podría causar fuego o choques eléctricos. 

9. En las mediciones en circuitos de corriente con una tensión Ueff > 30 V se deberán tomar las medidas 
apropiadas para impedir cualquier peligro (p. ej. medios de medición adecuados, seguros, limitación 
de tensión, corte protector, aislamiento etc.). 

10. Para la conexión con dispositivos informáticos como un PC o un ordenador industrial, debe 
comprobarse que éstos cumplan los estándares IEC60950-1/EN60950-1 o IEC61010-1/EN 61010-1 
válidos en cada caso. 

11. A menos que esté permitido expresamente, no retire nunca la tapa ni componentes de la carcasa 
mientras el producto esté en servicio. Esto pone a descubierto los cables y componentes eléctricos y 
puede causar lesiones, fuego o daños en el producto. 

12. Si un producto se instala en un lugar fijo, se deberá primero conectar el conductor de protección fijo 
con el conductor de protección del producto antes de hacer cualquier otra conexión. La instalación y 
la conexión deberán ser efectuadas por un electricista especializado. 

13. En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor automático ni otros 
mecanismos de seguridad similares, el circuito de alimentación debe estar protegido de modo que 
todas las personas que puedan acceder al producto, así como el producto mismo, estén a salvo de 
posibles daños. 

14. Todo producto debe estar protegido contra sobretensión (debida p. ej. a una caída del rayo) mediante 
los correspondientes sistemas de protección. Si no, el personal que lo utilice quedará expuesto al 
peligro de choque eléctrico. 

15. No debe introducirse en los orificios de la caja del aparato ningún objeto que no esté destinado a ello. 
Esto puede producir cortocircuitos en el producto y/o puede causar choques eléctricos, fuego o 
lesiones. 

16. Salvo indicación contraria, los productos no están impermeabilizados (ver también el capítulo 
"Estados operativos y posiciones de funcionamiento", punto 1). Por eso es necesario tomar las 
medidas necesarias para evitar la entrada de líquidos. En caso contrario, existe peligro de choque 
eléctrico para el usuario o de daños en el producto, que también pueden redundar en peligro para las 
personas. 

17. No utilice el producto en condiciones en las que pueda producirse o ya se hayan producido 
condensaciones sobre el producto o en el interior de éste, como p. ej. al desplazarlo de un lugar frío a 
otro caliente. La entrada de agua aumenta el riesgo de choque eléctrico. 

18. Antes de la limpieza, desconecte por completo el producto de la alimentación de tensión (p. ej. red de 
alimentación o batería). Realice la limpieza de los aparatos con un paño suave, que no se deshilache. 
No utilice bajo ningún concepto productos de limpieza químicos como alcohol, acetona o diluyentes 
para lacas nitrocelulósicas. 



Instrucciones de seguridad elementales 

1171.0000.42 - 06 Page 12 

Funcionamiento 

1. El uso del producto requiere instrucciones especiales y una alta concentración durante el manejo. 
Debe asegurarse que las personas que manejen el producto estén a la altura de los requerimientos 
necesarios en cuanto a aptitudes físicas, psíquicas y emocionales, ya que de otra manera no se 
pueden excluir lesiones o daños de objetos. El empresario u operador es responsable de seleccionar 
el personal usuario apto para el manejo del producto. 

2. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capítulo "Transporte". 

3. Como con todo producto de fabricación industrial no puede quedar excluida en general la posibilidad 
de que se produzcan alergias provocadas por algunos materiales empleados ―los llamados 
alérgenos (p. ej. el níquel)―. Si durante el manejo de productos Rohde & Schwarz se producen 
reacciones alérgicas, como p. ej. irritaciones cutáneas, estornudos continuos, enrojecimiento de la 
conjuntiva o dificultades respiratorias, debe avisarse inmediatamente a un médico para investigar las 
causas y evitar cualquier molestia o daño a la salud.  

4. Antes de la manipulación mecánica y/o térmica o el desmontaje del producto, debe tenerse en cuenta 
imprescindiblemente el capítulo "Eliminación/protección del medio ambiente", punto 1. 

5. Ciertos productos, como p. ej. las instalaciones de radiocomunicación RF, pueden a causa de su 
función natural, emitir una radiación electromagnética aumentada. Deben tomarse todas las medidas 
necesarias para la protección de las mujeres embarazadas. También las personas con marcapasos 
pueden correr peligro a causa de la radiación electromagnética. El empresario/operador tiene la 
obligación de evaluar y señalizar las áreas de trabajo en las que exista un riesgo elevado de 
exposición a radiaciones. 

6. Tenga en cuenta que en caso de incendio pueden desprenderse del producto sustancias tóxicas 
(gases, líquidos etc.) que pueden generar daños a la salud. Por eso, en caso de incendio deben 
usarse medidas adecuadas, como p. ej. máscaras antigás e indumentaria de protección. 

7. Los productos con láser están provistos de indicaciones de advertencia normalizadas en función de la 
clase de láser del que se trate. Los rayos láser pueden provocar daños de tipo biológico a causa de 
las propiedades de su radiación y debido a su concentración extrema de potencia electromagnética. 
En caso de que un producto Rohde & Schwarz contenga un producto láser (p. ej. un lector de 
CD/DVD), no debe usarse ninguna otra configuración o función aparte de las descritas en la 
documentación del producto, a fin de evitar lesiones (p. ej. debidas a irradiación láser). 

8. Clases CEM (según CISPR 11) 
Clase A: dispositivo apropiado para el uso en cualquier zona excepto en áreas residenciales y en 
aquellas zonas que se encuentran conectadas a una red de suministro de baja tensión que alimenta 
un edificio de viviendas. 
Clase B: dispositivo apropiado para el uso en áreas residenciales y en aquellas zonas que se 
encuentran conectadas a una red de suministro de baja tensión que alimenta un edificio de viviendas. 

Reparación y mantenimiento 

1. El producto solamente debe ser abierto por personal especializado con autorización para ello. Antes 
de manipular el producto o abrirlo, es obligatorio desconectarlo de la tensión de alimentación, para 
evitar toda posibilidad de choque eléctrico.  
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2. El ajuste, el cambio de partes, el mantenimiento y la reparación deberán ser efectuadas solamente 
por electricistas autorizados por Rohde & Schwarz. Si se reponen partes con importancia para los 
aspectos de seguridad (p. ej. el enchufe, los transformadores o los fusibles), solamente podrán ser 
sustituidos por partes originales. Después de cada cambio de partes relevantes para la seguridad 
deberá realizarse un control de seguridad (control a primera vista, control del conductor de 
protección, medición de resistencia de aislamiento, medición de la corriente de fuga, control de 
funcionamiento). Con esto queda garantizada la seguridad del producto.  

Baterías y acumuladores o celdas 

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a las baterías y 
acumuladores o celdas, pueden producirse explosiones, incendios y/o lesiones graves con posible 
consecuencia de muerte. El manejo de baterías y acumuladores con electrolitos alcalinos (p. ej. celdas de 
litio) debe seguir el estándar EN 62133. 

1. No deben desmontarse, abrirse ni triturarse las celdas.  

2. Las celdas o baterías no deben someterse a calor ni fuego. Debe evitarse el almacenamiento a la luz 
directa del sol. Las celdas y baterías deben mantenerse limpias y secas. Limpiar las conexiones 
sucias con un paño seco y limpio. 

3. Las celdas o baterías no deben cortocircuitarse. Es peligroso almacenar las celdas o baterías en 
estuches o cajones en cuyo interior puedan cortocircuitarse por contacto recíproco o por contacto con 
otros materiales conductores. No deben extraerse las celdas o baterías de sus embalajes originales 
hasta el momento en que vayan a utilizarse. 

4. Las celdas o baterías no deben someterse a impactos mecánicos fuertes indebidos. 

5. En caso de falta de estanqueidad de una celda, el líquido vertido no debe entrar en contacto con la 
piel ni los ojos. Si se produce contacto, lavar con agua abundante la zona afectada y avisar a un 
médico. 

6. En caso de cambio o recarga inadecuados, las celdas o baterías que contienen electrolitos alcalinos 
(p. ej. las celdas de litio) pueden explotar. Para garantizar la seguridad del producto, las celdas o 
baterías solo deben ser sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de 
recambios).  

7. Las baterías y celdas deben reciclarse y no deben tirarse a la basura doméstica. Las baterías o 
acumuladores que contienen plomo, mercurio o cadmio deben tratarse como residuos especiales. 
Respete en esta relación las normas nacionales de eliminación y reciclaje.  

Transporte 

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o transportarlo con 
precaución y, si es necesario, usando un sistema de elevación adecuado (p. ej. una carretilla 
elevadora), a fin de evitar lesiones en la espalda u otros daños personales.  

2. Las asas instaladas en los productos sirven solamente de ayuda para el transporte del producto por 
personas. Por eso no está permitido utilizar las asas para la sujeción en o sobre medios de transporte 
como p. ej. grúas, carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los 
productos de manera segura a los medios de transporte o elevación. Para evitar daños personales o 
daños en el producto, siga las instrucciones de seguridad del fabricante del medio de transporte o 
elevación utilizado. 
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3. Si se utiliza el producto dentro de un vehículo, recae de manera exclusiva en el conductor la 
responsabilidad de conducir el vehículo de manera segura y adecuada. El fabricante no asumirá 
ninguna responsabilidad por accidentes o colisiones. No utilice nunca el producto dentro de un 
vehículo en movimiento si esto pudiera distraer al conductor. Asegure el producto dentro del vehículo 
debidamente para evitar, en caso de un accidente, lesiones u otra clase de daños.  

Eliminación/protección del medio ambiente 

1. Los dispositivos marcados contienen una batería o un acumulador que no se debe desechar con los 
residuos domésticos sin clasificar, sino que debe ser recogido por separado. La eliminación se debe 
efectuar exclusivamente a través de un punto de recogida apropiado o del servicio de atención al 
cliente de Rohde & Schwarz. 

2. Los dispositivos eléctricos usados no se deben desechar con los residuos domésticos sin clasificar, 
sino que deben ser recogidos por separado. 
Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminación de residuos y asume 
plenamente los deberes de recogida y eliminación para los fabricantes dentro de la UE. Para 
desechar el producto de manera respetuosa con el medio ambiente, diríjase a su servicio de atención 
al cliente de Rohde & Schwarz. 

3. Si se trabaja de manera mecánica y/o térmica cualquier producto o componente más allá del 
funcionamiento previsto, pueden liberarse sustancias peligrosas (polvos con contenido de metales 
pesados como p. ej. plomo, berilio o níquel). Por eso el producto solo debe ser desmontado por 
personal especializado con formación adecuada. Un desmontaje inadecuado puede ocasionar daños 
para la salud. Se deben tener en cuenta las directivas nacionales referentes a la eliminación de 
residuos. 

4. En caso de que durante el trato del producto se formen sustancias peligrosas o combustibles que 
deban tratarse como residuos especiales (p. ej. refrigerantes o aceites de motor con intervalos de 
cambio definidos), deben tenerse en cuenta las indicaciones de seguridad del fabricante de dichas 
sustancias y las normas regionales de eliminación de residuos. Tenga en cuenta también en caso 
necesario las indicaciones de seguridad especiales contenidas en la documentación del producto. La 
eliminación incorrecta de sustancias peligrosas o combustibles puede causar daños a la salud o 
daños al medio ambiente. 

Se puede encontrar más información sobre la protección del medio ambiente en la página web de 
Rohde & Schwarz. 



Sehr geehrter Kunde,
Sie haben sich für den Kauf eines 
Rohde & Schwarz- Produktes ent-
schieden. Sie erhalten damit ein 
nach modernsten Fertigungsme-
thoden hergestelltes Produkt. Es 
 wurde nach den Regeln  unseres 
Qualitätsmanagementsystems 
entwickelt, gefertigt und geprüft. 
Das  Rohde & Schwarz-Qualitäts-
managementsystem ist unter 
anderem nach ISO 9001 und 
ISO 14001  zertifiziert. 

Der Umwelt verpflichtet
 ❙ Energie-effi ziente, 
RoHS-konforme Produkte

 ❙ Kontinuierliche 
Weiterentwicklung nachhaltiger 
 Umweltkonzepte

 ❙ ISO 14001-zertifi ziertes 
Umweltmanagementsystem

Dear customer,
You have decided to buy a 
Rohde & Schwarz product. You 
are thus assured of receiving a 
product that is manufactured 
using the most modern methods 
available. This product was de-
veloped, manufactured and test-
ed in compliance with our quality 
management system standards. 
The  Rohde & Schwarz quality 
management system is certified  
according to standards such as 
ISO 9001 and ISO 14001. 

Environmental commitment
 ❙ Energy-effi cient products
 ❙ Continuous improvement in 
environmental sustainability

 ❙ ISO 14001-certifi ed 
environmental management 
system

Cher client,
Vous avez choisi d’acheter un 
produit Rohde & Schwarz. Vous 
disposez donc d’un produit 
fabriqué d’après les méthodes 
les plus avancées. Le développe-
ment, la fabrication et les tests 
respectent nos normes de ges-
tion qualité. Le système de ges-
tion qualité de Rohde & Schwarz 
a été homologué, entre autres, 
conformément aux normes 
ISO 9001 et ISO 14001. 

Engagement écologique
 ❙ Produits à effi cience 
énergétique 

 ❙ Amélioration continue de la 
durabilité environnementale

 ❙ Système de gestion de 
l’environnement certifi é selon 
ISO 14001

Certifi ed Environmental System

ISO 14001

Certifi ed Quality System

ISO 9001
Qualitätszertifikat
Certificate of quality
Certificat de qualité
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Customer Support 
 

Technical support – where and when you need it 
For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer Support 
Centers. A team of highly qualified engineers provides telephone support and will work with you to find a 
solution to your query on any aspect of the operation, programming or applications of Rohde & Schwarz 
equipment. 
 

Up-to-date information and upgrades 
To keep your instrument up-to-date and to be informed about new application notes related to your 
instrument, please send an e-mail to the Customer Support Center stating your instrument and your wish. 
We will take care that you will get the right information. 
 

Europe, Africa, Middle East Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com

North America Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com

Latin America Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com

Asia/Pacific Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com

China Phone +86-800-810-8228 /  
 +86-400-650-5896 
customersupport.china@rohde-schwarz.com

mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport@rohde-schwarz.com
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1 MIMO OTA Testing
R&S AMS32 implements special dedicated tests for evaluating the OTA performance of
receivers in MIMO mode. To configure and use these tests, option R&S AMS32-K31 must
be installed and activated.

There are many possible MIMO configurations. The R&S AMS32 implementation covers
the following:
● MIMO tests are tests on the EUT's receiver performance, that is, sensitivity tests on

the downlink. No uplink or EUT transmitter MIMO is considered.
● The downlink MIMO channel has a 2x2 configuration, that is, two downlink signal

streams are generated. MIMO channel configurations of higher order are not con-
sidered.

● R&S AMS32 supports the LTE (FDD or TDD) radio technology for MIMO testing. The
R&S CMW500, equipped with the LTE Signaling software application, is to be used
as communication tester. The following R&S CMW options are required: R&S CMW-
KS500, "LTE FDD Signaling" or R&S CMW-KS550, "LTE TDD Signaling" plus R&S
CMW-KS520, "LTE MIMO Signaling". An R&S CMW base software version ≥V2.1.10
and an R&S CMW LTE Signaling software version ≥V2.1.21 ensures the full func-
tionality described in this manual.
Option R&S AMS32-K29 provides the required device driver for the R&S CMW500.
Extension to other radio technologies is planned.

The test cases implemented in R&S AMS32 for evaluation of the OTA performance of a
MIMO receiver are based on the MIMO OTA test plan presented by Rohde & Schwarz,
together with other companies and institutions, to the standardization bodies. In this test
plan, two test cases are identified as being sufficient for a characterization of the MIMO
OTA performance of a EUT:
● A test of the "noise-limited performance in transmit diversity mode" involves a single

cross-polarized antenna. The two downlink streams are fed to the two orthogonal
polarizations of the antenna. This test case is performed according to ​chapter 2,
"Noise-Limited OTA Performance in Transmit Diversity Mode", on page 6.

● A test of the "peak performance in spatial multiplexing mode" involves two cross-
polarized antennas with variable offset. This test case is performed according to ​
chapter 3, "Peak Performance in Spatial Multiplexing Mode ", on page 21.

These test cases and their implementation in R&S AMS32 are described in this user
manual. For theoretical background and more details, please refer to Rohde & Schwarz
Application Note 1SP12, "Two-Channel Method for OTA Performance Measurements of
MIMO-Enabled Devices", which can be downloaded from the Rohde & Schwarz home-
page (see http://www2.rohde-schwarz.com/en/service_and_support/Downloads/Appli-
cation_Notes?discontinued=all&type=20&downid=5905).

 

http://www2.rohde-schwarz.com/en/service_and_support/Downloads/Application_Notes?discontinued=all&type=20&downid=5905
http://www2.rohde-schwarz.com/en/service_and_support/Downloads/Application_Notes?discontinued=all&type=20&downid=5905
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2 Noise-Limited OTA Performance in Transmit
Diversity Mode
This test case fundamentally consists in generating a two-stream signal in TX diversity
mode, and transmitting these two streams simultaneously to the EUT through the two
polarizations of the same cross-polarized measurement antenna (e.g. a quad-ridged
horn). TX diversity mode means that the two streams essentially contain the same data
so that there is no gain in the maximum data rate. The purpose of this single-antenna
MIMO OTA test is to determine the sensitivity threshold of the EUT when the downlink
signal is as stable and robust as possible.

According to the test case specification, the sensitivity threshold is defined as the mini-
mum downlink signal level at the EUT location that results in a block error rate (BLER)
lower than the threshold value of 10%. The level of an LTE downlink signal is defined in
terms of the RS EPRE (energy per resource element of the reference signal; see ​chap-
ter 2.1.2.2, "Communication Settings", on page 11). With a properly calibrated test
setup, the powers of the horizontal and the vertical signal components at the UE location
are equal, and both correspond to the RS EPRE set at the R&S CMW500 (see also ​
chapter 2.1.1, "Hardware Setup", on page 7).

In addition to the sensitivity threshold levels at arbitrary angular positions, the single-
antenna test case provides derived quantities such as the cumulative distribution function
(CDF) which serves as an overall figure of merit for the EUT.

As just one test antenna is used for this test, the configuration and test run is very similar
to the standard SISO OTA test which is described in the R&S AMS32 help system. More-
over, a SISO test chamber is sufficient for the test. The following sections describe spe-
cific MIMO OTA configurations and results.

2.1 Configuration

The configuration of a single-antenna MIMO OTA setup involves the following steps:

1. In the "Sensitivity" tab of the "Hardware Setup" dialog, select the appropriate setup
"MIMO 2x2 with single cross-polarized test antenna". See ​chapter 2.1.1, "Hardware
Setup", on page 7.

 

 

Configuration
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2. Select this hardware setup in the "General Settings" sub-dialog of an OTA test tem-
plate. See ​chapter 2.1.2.1, "Hardware Setup Selection", on page 10.

3. In the "Communication Settings" sub-dialog, configure the radio link as required. Take
special care to select "TX Diversity" as a transmission scheme and to configure a
low-order, robust modulation scheme, typically QPSK, with a low transport block size
index. See ​chapter 2.1.2.2, "Communication Settings", on page 11.

4. In the "Fading Settings" sub-dialog, modify the static channel model of the commu-
nication tester, if desired. See ​chapter 2.1.2.4, "Fading Settings", on page 13.

2.1.1 Hardware Setup

In the "Hardware Setup" dialog, you can select the desired test case and call the R&S
CMW500 LTE driver configuration dialog in order to perform basic RF configurations.

Access: "File > Hardware Setup Open/New..." in the R&S AMS32 main dialog window
(keyboard shortcut "Ctrl+H"). In the "Hardware Setup Open" dialog opened, select "New
> OTA Measurements" and click "OK".

The "noise-limited OTA performance test in transmit diversity mode" corresponds to the
selection "MIMO 2x2 with single cross-polarized test antenna" in the "Sensitivity" tab.

Fig. 2-1: Hardware setup for single-antenna tests

After selection of the test setup, a previously loaded R&S "CMW500-LTE" driver appears
in the yellow information field below the communication tester symbol (click "Extras >
Device List..." to load or configure the driver). You may also have to load drivers for the
positioner and antenna and select the two signal paths (right-click the "dB" symbols and

 

Configuration
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select "Sensitivity Horizontal" and "Sensitivity Vertical") as shown above. The test setup
remains fixed during the entire measurement; the two streams of the LTE downlink signal
from the R&S CMW500 are simultaneously fed to the two polarizations of the test
antenna.

To define the RF connector and external attenuation settings at the communication tester,
left-click the R&S CMW500 device symbol and open the "Settings" tab of the device driver
configuration dialog.

Fig. 2-2: RF input and output settings

Check "Set up RF Connectors during Test", select the RF input connector plus the two
RF output connectors at the R&S CMW500, and enter the external attenuations according
to your physical test setup. Notice that the "RF Output" is to be linked to the antenna
connector for the horizontal polarization (---> HOR), the "RF Output 2" to the vertical one
(--> VER).

The external attenuation of the "RF Output 2" does not appear as a configurable value;
it is automatically set with the aim of generating equal power densities of both downlink
streams at the EUT location. To achieve this, the external attenuation of "RF Output 2"
is set to the external attenuation value of "RF Output", corrected by the difference of the
attenuation values in the output attenuation tables associated with the two connectors.
This rule ensures equal power densities, provided that both downlink paths have been
correctly calibrated, so that the output attenuation tables reflect the true path attenuations.

Click "OK" to save your R&S CMW500 driver settings. Back in the "Hardware Setup"
dialog, the "RF In/Out" settings appear in the white information field below the R&S
CMW500 device symbol. Click "OK" to save your hardware setup, assigning an appro-
priate file name (e.g. "OTA Measurements_Single Antenna").

Configuration



Noise-Limited OTA Performance in Transmit Diversity ModeR&S®AMS32-K31

9User Manual 1175.6678.02 ─ 01

2.1.2 OTA Test Template

In the "OTA Auto Test Template" dialog, you can configure your MIMO OTA test and
store your settings to a template file which you may use repeatedly.

Access: "File > Test Template Open/New..." in the R&S AMS32 main dialog window
(keyboard shortcut "Ctrl+E") or "EMC32 Explorer > Open Test Template". In the "Hard-
ware Setup Open" dialog opened, select "New > OTA Auto Test" and click "OK".

Select your "OTA Test Method: Sensitivity Mobile Phone" as shown below.

Fig. 2-3: OTA Auto Test Template dialog (default configuration)

For a new single-antenna MIMO OTA test, you may typically have to open the "General
Settings" dialog to select your hardware setup and adjust the "Communication Set-
tings". After performing your configurations, click "OK" to save your test to a file with an
appropriate name.
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2.1.2.1 Hardware Setup Selection

In the "General Settings" dialog, you can select your previously configured hardware
setup (see ​chapter 2.1.1, "Hardware Setup", on page 7).

Access: "General Settings" button in the "OTA Auto Test Template" dialog; see ​fig-
ure 2-3.

In general, you will have to select your "Hardware Setup" and specify the "Mobile Phone
Network" (LTE-FDD or TD-LTE). Click "OK" to confirm your settings and return to the
"OTA Auto Test Template" dialog. The contents of this dialog change as shown below.

Fig. 2-4: OTA Auto Test Template dialog for a MIMO OTA test
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2.1.2.2 Communication Settings

The R&S CMW500 LTE driver provides a configuration dialog for the basic properties of
the LTE downlink signal of the R&S CMW500 ("Cell Setup" and "Connection" settings).

Access: "Communication Settings" button in the "OTA Auto Test Template" dialog; see
​figure 2-4.

The contents of the driver configuration dialog depend on the radio technology. For LTE
MIMO OTA tests, you can open the "Cell Setup" tab in order to select the bandwidth and
modify the DL and UL power settings. Check "Setup Cell Parameters" to transfer your
settings to the R&S CMW500.

Downlink levels for MIMO sensitivity tests
The RS EPRE (energy per resource element of the reference signal) defines all downlink
physical channel levels of the R&S CMW500. A sensitivity measurement involves repea-
ted BLER measurements at variable RS EPRE settings. The sensitivity threshold, i.e. the
RS EPRE at which the BLER crosses the 10% threshold, is returned as the basic mea-
surement result.
The RS EPRE setting in the driver configuration dialog merely serves as a start value for
the sensitivity measurement; the complete sequence of RS EPRE values measured is
logged in a file LteMimoData.csv; see ​figure 2-7. An RS EPRE setting close to the
sensitivity threshold can accelerate the measurement.
R&S AMS32 allows you to modify the specified 10 % value for the BLER threshold; see
​chapter 2.1.2.3, "Measurement Settings", on page 12. See also "Normalization of sen-
sitivity threshold levels" in ​chapter 2.3, "Result Evaluation and Reporting",
on page 16.
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In the "Connection" tab of the driver configuration dialog, you can select the DL "Trans-
mission Scheme" and the allocated DL and UL resource blocks. Check "Setup Connec-
tion" to transfer your settings to the R&S CMW500.

To measure in line with the test case "noise-limited OTA performance in transmit diversity
mode", select "TX Diversity" as a transmission scheme and to configure a low-order,
robust modulation scheme, typically QPSK, with a low transport block size index.

For detailed information about the communication settings, refer to the R&S CMW500
documentation. Click "OK" to confirm your settings and return to the "OTA Auto Test
Template" dialog.

2.1.2.3 Measurement Settings

In the "Measurement Settings" dialog, you can select the measured quantity and test
procedure and specify the measurement statistics.

Access: "Measurement Settings" button in the "OTA Auto Test Template" dialog; see ​
figure 2-4.
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The "Target Value" is the BLER at which the sensitivity level is reached. The test case
specification stipulates a 10 % target value.

Click "OK" to confirm your settings and return to the "OTA Auto Test Template" dialog.

2.1.2.4 Fading Settings

The "Fading Settings" dialog shows the parameters of the static channel model that the
R&S CMW500 uses for the MIMO tests. "Static Channel Model with Communication
Tester" must be selected for MIMO OTA tests.

MIMO OTA test cases and fading
The Rohde & Schwarz MIMO OTA test cases do not require a faded downlink LTE signal.
The settings described in this section have been added to support further investigations.

Access: "Fading Settings" button in the "OTA Auto Test Template" dialog; see ​fig-
ure 2-4.
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A left-click on the device symbol in the upper part of the dialog opens the R&S CMW500
LTE driver configuration dialog.

With enabled static channel model, it is possible to select two magnitudes of the channel
matrix elements, | h11 | and | h21 |. The magnitudes of the remaining elements are auto-
matically readjusted to maintain the downlink power: | h12 | = 1 – | h11 | and | h22 | = 1
– | h21 | . The four phases Ph11 ... Ph22 can be defined independently in multiples of 15
degrees. With disabled channel model, the two downlink data streams are not cross-
correlated (| h12 | = | h21 | = 0).

For detailed information about the channel model settings, refer to the R&S CMW500
documentation. Click "OK" to confirm your settings and return to the "OTA Auto Test
Template" dialog.

2.1.2.5 Loop Settings

In the "Loop Settings" dialog, you can define the measured radio channels and angular
positions ("Azimuth", "Elevation"). The MIMO OTA tests will be performed at all selected
radio channels and angles.

Access: "Loop Settings" button in the "OTA Auto Test Template" dialog; see ​figure 2-4.
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The test setup for the single-antenna MIMO OTA test is fixed, with no switching between
polarizations, so there is no configurable "Polarization" loop. This simplifies the test result
generation and reduces the number of graphs and result tables; see ​chapter 2.3, "Result
Evaluation and Reporting", on page 16. Besides, the loop settings for single-antenna
MIMO OTA tests correspond to the loop settings for SISO tests.

Click "OK" to confirm your settings and return to the "OTA Auto Test Template" dialog.

2.2 Test Run

Once the test template has been defined as outlined in the previous sections, a single-
antenna MIMO OTA test is performed in close analogy to the SISO OTA test described
in the R&S AMS32 help system. The test run involves the following stages:

1. Click "Test > Test (Sequence) Open/New"... (or "Ctrl+T"), select "New > OTA Meas-
urements", and click "OK" to open the "New Test" dialog. Create a new R&S AMS32
test, based on your MIMO OTA test template.
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Click "OK" to create, save, and initialize the test.

2. Use the "Play", "Pause", and "Stop" buttons in the test control toolbar at the bottom
of the R&S AMS32 main application window to control test execution.

3. Observe the results as they appear in the main window; see ​Result Evaluation and
Reporting.

2.3 Result Evaluation and Reporting

During a test run, the measured sensitivity thresholds (or effective isotropic sensitivities,
EIS), i.e. the LTE downlink levels (RS EPRE) at which the BLER crosses the specified
threshold (e.g. 10 % BLER), are displayed in polar graphs. A polar graph is generated
for each measured channel.

The angles in the polar graphs correspond to the azimuth angles; the radial axes to the
EIS. Each graph shows a separate EIS vs. azimuth trace for each elevation. You can
point on the measurement points or double-click in order to set markers and retrieve
numeric results.
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In addition to the polar graphs, the following information panes appear in the R&S AMS32
main application window.
● The "Test Components" explorer pane (docked to the left side of the window) shows

the following files: "Graphics" (graphs/diagrams for data presentation and associated
*.wmf files for viewing in an external application or printout), "Reports" "Report Set-
ups" (if defined) and "Result Tables".

A MIMO OTA test yields one graphics file and one result table file for each measured
channel. The file names contain the polarization indicator ..._hor. Double-click a
file to select or open it. Right-click a nodes or file to retrieve related information (e.g.
the directories where the test is stored).

● The "OTA Test Control" window (docked to the right side of the window) shows the
range and current value of the loop parameters. The fixed polarization configuration
for the single-antenna MIMO OTA test is displayed as "Hor-Ver".

Result Evaluation and Reporting
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Report settings
R&S AMS32 provides a wide range of settings for measurement reports. To change the
default configuration, you can click the "Report Settings" button in the "OTA Auto Test
Template" dialog (see ​figure 2-4) before you save your test template.

At the end of the test run, when all test results have been acquired, R&S AMS32 calcu-
lates the following additional results:
● A 3D graph for each channel shows the measured sensitivity thresholds (in dBm)

over the full sphere.

Fig. 2-5: Example of a 3D graph

● The cumulative distribution function (CDF) of the sensitivity threshold levels for all
angular positions is calculated. The CDF result is also saved to a table named
CDF_....
In the example below, the CDF corresponds to the blue curve. The red dots show the
percentage of measurement results which fall in each sensitivity threshold interval
(defined by the "Min. level resolution" in the "Measurement Settings" dialog; see ​
chapter 2.1.2.3, "Measurement Settings", on page 12). You can mouse over the

Result Evaluation and Reporting
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measurement points or double-click in order to set markers and retrieve numeric
results.

Fig. 2-6: Example of a CDF graph

According to the test case specification, the CDF serves as the overall figure of merit
for the EUT. CDF(x dBm) = y % means that y % of all sensitivity thresholds (measured
at arbitrary angles) are ≤ x dBm. In the example above, all measured sensitivity
thresholds are ≤ –95 dBm, but none of them was found to be ≤ –106 dBm.
The lower the recorded sensitivity threshold levels, the better the EUT’s MIMO per-
formance. The steeper the CDF curve, the more uniform the antenna performance.

● The "Avg. Throughput" and "CCDF" graphs are required for dual-antenna tests and
decribed in the relevant chapter; see ​figure 3-3 and ​figure 3-4.

● The "MIMO Report" contains the result tables, the CDF graph, the average through-
put and CCDF graphs, and all 3D graphs. A separate report file is generated for each
RF channel.

Notice that some of the SISO OTA test results (e.g. the Total Isotropic Sensitivity, TIS)
are not relevant for the MIMO test cases and therefore not calculated.

Result Evaluation and Reporting
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Normalization of sensitivity threshold levels
The levels in the CDF, Avg. Throughput, and CCDF graphs and tables are expressed in
units of dBm/15 kHz, which corresponds to the normalization of the RS EPRE values
(see ​"Downlink levels for MIMO sensitivity tests" on page 11). 15 kHz is the fixed sub-
carrier spacing of the LTE signal.
Multiplying the RS EPRE with the number of subcarriers per band yields the "full cell
bandwidth power" values. If desired, R&S AMS32 can convert the levels in the CDF
graphs and tables to full cell bandwidth powers (click "Extras > Options > OTA
Options" and check "Correct LTE TIS power level for EPRE offset" in the "Test Control"
tab of the dialog opened). You can also re-calculate the CDF results of an exisiting test
in order to convert the levels ("Test > OTA MIMO Evaluation > (C)CDF EValuation... >
Do Evaluation").
The number of subcarriers depends of the cell bandwidth. E.g. for a 10 MHz band, the
number is 600, so the full bandwidth powers are 10 * log(600) dB = 27.78 dB above the
RS EPRE values

In addition to the sensitivity thresholds measured at each point, which are saved to the
"Result Tables" of the test, R&S AMS32 logs the BLER and throughput values measured
at every downlink level during the test. The data are logged to a file
LteMimoData.csv in the test’s \System sub-folder. The layout of this *.csv file is as
shown below.

Fig. 2-7: LteMimoData.csv file opened in Microsoft® Excel

Result Evaluation and Reporting
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3 Peak Performance in Spatial Multiplexing
Mode
This test case fundamentally consists in generating a two-stream signal in spatial multi-
plexing mode, and transmitting these two streams simultaneously to the DUT through
two different test antennas moving independently to different positions. Spatial multi-
plexing mode means that the two streams are filled with different data so that the maxi-
mum data rate can be increased by a factor of two compared to SISO operation.

Each test antenna is a cross-polarized one (e.g. a quad-ridged horn), so it is possible to
feed each signal to any of the two polarizations of the test antenna. The purpose of this
dual-antenna test is to determine the performance of the UE when high data rates are
streamed under good channel conditions.

In addition to the sensitivity threshold levels at arbitrary angular positions, the dual-
antenna test case provides derived quantities such as the cumulative distribution function
(CDF), the average throughput, and the complementary cumulative distribution function
(CCDF) of the relative throughput results which serves as an overall figure of merit for
the EUT.

The following sections describe specific dual-antenna MIMO OTA configurations and
results.

3.1 Configuration

The configuration of a dual-antenna MIMO OTA setup involves the following steps:

1. In the "Sensitivity" tab of the "Hardware Setup" dialog, select the appropriate setup
"MIMO 2x2 with variable offset between test antennas". See ​chapter 3.1.1, "Hardware
Setup", on page 22.
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2. Select this hardware setup in the "General Settings" sub-dialog of an OTA test tem-
plate. See ​chapter 3.1.2.1, "Hardware Setup Selection", on page 24.

3. In the "Loop Settings" sub-dialog, configure the sequence of angular positions to be
accessed during the test. A special extended MIMO version of this sub-dialog is
available, as an additional loop may be defined for the second test antenna. See ​
chapter 3.1.2.5, "Loop Settings", on page 26.

4. In the "Communication Settings" sub-dialog, configure the radio link as required. Take
special care to select open loop spatial multiplexing as a transmission scheme and
to configure a high-order modulation scheme, typically 64QAM, with a high transport
block size index. See ​chapter 3.1.2.2, "Communication Settings", on page 25.

5. In the "Fading Settings" sub-dialog, modify the static channel model of the commu-
nication tester, if desired. See ​chapter 3.1.2.4, "Fading Settings", on page 26.

3.1.1 Hardware Setup

In the "Hardware Setup" dialog, you can select the desired test case and call the R&S
CMW500 LTE driver configuration dialog in order to perform basic RF configurations.

Access: "File > Hardware Setup Open/New..." in the R&S AMS32 main dialog window
(keyboard shortcut "Ctrl+H"). In the "Hardware Setup Open" dialog opened, select "New
> OTA Measurements" and click "OK".

The "peak performance test in spatial multiplexing mode" corresponds to the selection
"MIMO 2x2 with variable offset between test antennas" in the "Sensitivity" tab.
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Fig. 3-1: Hardware setup for dual-antenna tests

After selection of the test setup, a previously loaded R&S "CMW500-LTE" driver appears
in the yellow information field below the communication tester symbol (click "Extras >
Device List..." to load or configure the driver). You may also have to load drivers for the
positioner and antennas and select the four signal paths (right-click the "dB" symbols and
select "Sensitivity Horizontal" and "Sensitivity Vertical") as shown above. The two cross-
polarized test antennas provide four different polarization combinations (H – H, H – V, V
– H, V – V). To measure all these combinations in a fixed test setup ("polarization loop";
see ​chapter 3.1.2.5, "Loop Settings", on page 26), the first RF output connector of the
R&S CMW500 must supply both vertical antenna connectors, the second RF output con-
nector both horizontal antenna connectors. An RF switch unit is required for this test
setup. Double-click the switch symbol, provide the required path information, and cali-
brate your test setup in order ensure equal path attenuations and equal power densities
of all antenna signals at the EUT location.

To define the RF connector and external attenuation settings at the communication tester,
left-click the R&S CMW500 device symbol and open the "Settings" tab of the device driver
configuration dialog. The settings are identical to the single-antenna test case; see ​fig-
ure 2-2. Click "OK" to save your hardware setup, assigning an appropriate file name (e.g.
"OTA Measurements_Dual Antenna").

3.1.2 OTA Test Template

In the "OTA Auto Test Template" dialog, you can configure your MIMO OTA test and
store your settings to a template file which you may use repeatedly.
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Access: "File > Test Template Open/New..." in the R&S AMS32 main dialog window
(keyboard shortcut "Ctrl+E") or "EMC32 Explorer > Open Test Template". In the "Hard-
ware Setup Open" dialog opened, select "New > OTA Auto Test" and click "OK".

Select your "OTA Test Method: Sensitivity Mobile Phone" as shown below.

Fig. 3-2: OTA Auto Test Template dialog (default configuration)

For a new dual-antenna MIMO OTA test, you may typically have to open the "General
Settings" dialog to select your hardware setup and adjust the "Communication Set-
tings" and the "Loop Settings". After performing your configurations, click "OK" to save
your test to a file with an appropriate name.

3.1.2.1 Hardware Setup Selection

In the "General Settings" dialog, you can select your previously configured hardware
setup (see ​chapter 3.1.1, "Hardware Setup", on page 22).
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Access: "General Settings" button in the "OTA Auto Test Template" dialog; see ​fig-
ure 3-2.

The settings are analogous to the single-antenna test case. The contents of the "OTA
Auto Test Template" dialog change as shown in ​figure 2-4.

3.1.2.2 Communication Settings

The R&S CMW500 LTE driver provides a configuration dialog for the basic properties of
the LTE downlink signal of the R&S CMW500 ("Cell Setup" and "Connection" settings).

Access: "Communication Settings" button in the "OTA Auto Test Template" dialog; see
​figure 2-4.

The "Cell Setup" parameters are identical to the single-antenna test case; see ​chap-
ter 2.1.2.2, "Communication Settings", on page 11. In the "Connection" tab of the driver
configuration dialog, you can select the DL "Transmission Scheme" and the allocated DL
and UL resource blocks. Check "Setup Connection" to transfer your settings to the R&S
CMW500.

To measure in line with the test case "peak performance in spatial multiplexing mode",
select "Open Loop Multiplex" as a transmission scheme and to configure a high-order
modulation scheme, typically 64QAM, with a high transport block size index (TBSI).

For detailed information about the communication settings, refer to the R&S CMW500
documentation. Click "OK" to confirm your settings and return to the "OTA Auto Test
Template" dialog.
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3.1.2.3 Measurement Settings

The "Measurement Settings" settings are analogous to the single-antenna test case; see
​chapter 2.1.2.3, "Measurement Settings", on page 12.

3.1.2.4 Fading Settings

The "Fading Settings" settings are analogous to the single-antenna test case; see ​chap-
ter 2.1.2.4, "Fading Settings", on page 13.

3.1.2.5 Loop Settings

In the "Loop Settings" dialog, you can define the measured polarizations, radio channels,
and angular positions ("Azimuth", "Elevation"). The MIMO OTA tests will be performed
at all selected parameter combinations, however, both antennas are positioned at a
common "Azimuth" angle, and their elevations (polar angles) are coupled as described
below. A restricted number of measured "Radio Channels" and angles will keep test times
and result lists short.

Access: "Loop Settings" button in the "OTA Auto Test Template" dialog; see ​figure 2-4.

The test setup for the dual-antenna MIMO OTA test provides four possible polarization
combinations (H – H, H – V, V – H, V – V). According to the test case specification, all
four combinations must be measured as shown above.

To keep the geometry simple and reduce test times, the angular positions of the two test
antennas are coupled as follows:
● Both antennas are at the same "Azimuth" angle, i.e. their positions are on a circle

centered upon the EUT position.
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● The polar angle of the second antenna ("Secondary Elevation)" is defined relative to
the polar angle of the first antenna ("Primary Elevation)"; see "Secondary Elevation
Loop Settings" below.

The "Secondary Elevation Loop Settings" have the following effect:
● Elevation angle is inverted in sign... means that, if the primary elevation is swept

from 15 deg to 165 deg, the secondary elevation is swept from –15 deg to –165 deg,
covering the opposite half circle around the EUT location. This selection corresponds
to the Rohde & Schwarz MIMO OTA test case specifications.

● Elevation is fixed during test means that the second measurement antenna is at a
fixed position in the chamber, either on purpose or because there is no additional
positioner available for automatic position control. The value range of the secondary
elevation is the positioning range of the positioner associated to the secondary
antenna in the hardware setup. Typically, this should be the same range as the one
of the primary antenna’s positioner, inverted in sign. An example of such a configu-
ration is a great-circle cut system (primary measurement antenna fixed and EUT
being rotated in two axes). It is extended by a second test antenna, also at a fixed
location inside the chamber.

● Elevation angle is at fixed offsets... means that a fixed angular offset between the
test antennas is maintained during the test. If several offset angles are specified, the
complete position sweep is repeated for each offset.

You can also choose to "Define test positions with a file" containing both azimuth and
elevation angles in R&S AMS32 table format. R&S AMS32 checks the loaded files for
consistency; refer to the help system for details.

Click "OK" to confirm your settings and return to the "OTA Auto Test Template" dialog.
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3.2 Test Run

Once the test template has been defined as outlined in the previous sections, a dual-
antenna MIMO OTA test is performed in close analogy to the single-antenna test. The
test run involves the following stages:

1. Click "Test > Test (Sequence) Open/New"... (or "Ctrl+T"), select "New > OTA Meas-
urements", and click "OK" to open the "New Test" dialog. Create a new R&S AMS32
test, based on your MIMO OTA test template.

Click "OK" to create, save, and initialize the test.

2. Use the "Play", "Pause", and "Stop" buttons in the test control toolbar at the bottom
of the R&S AMS32 main application window to control test execution.

3. Observe the results as they appear in the main window; see ​Result Evaluation and
Reporting.

3.3 Result Evaluation and Reporting

During a test run, the measured sensitivity thresholds (or effective isotropic sensitivities,
EIS), i.e. the LTE downlink levels (RS EPRE) at which the BLER crosses the specified
threshold (e.g. 10% BLER), are displayed in polar graphs. In addition, the "Test Compo-
nents" and "OTA Test Control" panes are displayed, in close analogy to the single-
antenna test case described in ​chapter 2.3, "Result Evaluation and Reporting",
on page 16.
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Compared to the single-antenna test case, the number of polar graphs, graphics files,
and result tables is multiplied by the number of measured polarization combinations. If
all four combinations are measured, the number of results is quadrupled.

Layout and contents of result tables
The layout of the result tables (SNS_... files) is the same as in the single-antenna test
case, i.e. the first column in the table contains the azimuth values, the following columns
contain the values recorded for a fixed value of the primary elevation. The secondary
elevation is not explicitly stated in the result table, but must be inferred from the config-
uration for the secondary elevation.
Therefore, at the end of the test, additional result tables containing the secondary ele-
vation are generated. These result tables are named UECoord... instead of
SNS_.... They comprise a total of five columns, the first two containing the azimuth
values for both antennas, the next two containing the elevation values, and the final col-
umn holding the measured value for each position defined by the first four fields in the
row. The polarization combination is indicated by the file name.

At the end of the test run, when all test results have been acquired, R&S AMS32 calcu-
lates the following additional results.
● A 3D graph for each channel and polarization combination shows the measured sen-

sitivity thresholds (in dBm) over the full sphere. No 3D graphs are generated if the
measured angles are loaded from a configuration file, which typically implicates large
or irregular angular steps. See also ​figure 2-5.

● The CDF of the sensitivity thresholds for all angular positions and polarization com-
binations is displayed in a diagram. The CDF function is also saved to a table named
CDF_.... See also ​figure 2-6.

● The average throughput for all measurement results which fall in each 0.5 dB-wide
downlink level interval is calculated. Throughput results for all angles and polarization
combinations are averaged. The average throughput result is also saved to a table
named AvgThr_....
The upper diagram edge shows the maximum DL throughput, depending on the cell
parameters. The lower the levels are at which high throughput values are reached,
the better is the EUT’s MIMO performance.

Result Evaluation and Reporting
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Fig. 3-3: Example of an average throughput graph

● The complementary cumulative distribution function (CCDF) of the relative through-
put values is calculated for all recorded downlink levels. "Relative throughput"
denotes the measured throughput, divided by the maximum throughput of the cell.
The CCDF results are also saved to a table named CCDF_.... In the example below,
each of the colored curves shows the CCDF for a specific downlink level.

Fig. 3-4: Example of a CCDF graph

According to the test case specification, the CCDF serves as the overall figure of
merit for the EUT. CCDF(x %) = y % means that y % of all relative throughput values
(measured at fixed downlink level but at arbitrary angles and polarization combina-
tions) are ≥ x %. In the example above, at the level of lower curve, none of the relative
throughput values was found in more than 50 % of the test constellations. At the
(higher) level of the upper curve, almost all test constellations yielded a relative
throughput close to one.

Result Evaluation and Reporting
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The lower the downlink level is at which a certain CCDF value is reached, the better
is the UE’s MIMO performance.

● The "MIMO Report" contains the result tables, the CDF graph, the average through-
put and CCDF graphs, and all 3D graphs. A separate report file is generated for each
RF channel.

Normalization of downlink levels and sensitivity threshold levels
The levels in the CDF, Avg. Throughput, and CCDF graphs and tables are either refer-
enced to the subcarrier spacing (dBm/15 kHz values) or to the full cell bandwidth (dBm/
10 MHz values). You can switch the scale as described in ​chapter 2.3, "Result Evaluation
and Reporting", on page 16.

In addition to the sensitivity thresholds measured at each point, which are saved to the
result table of the test, R&S AMS32 logs the BLER and throughput values measured at
every downlink level during the test. The data are logged to a file LteMimoData.csv in
the test’s \System sub-folder. The layout of this *.csv file is analogous to the single-
antenna test case; see ​figure 2-7.

The example below shows a complete test result for a dual-antenna measurement for a
single RF channel and four polarization combinations.

Result Evaluation and Reporting
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Glossary: MIMO OTA Testing
B

BLER: Block error rate

C
CTIA: Cellular Telecommunications & Internet Association

D
DL: Downlink

E
EIS: Effective isotropic sensitivity (per single geometrical point)

EUT: Equipment under test

F
FDD: Frequency division duplex (LTE technology)

L
LTE: Long term evolution (radio technology)

M
MS: Mobile phone, mobile station

O
OTA: Over-the-air (tests)

R
RF: Radio frequency

RS EPRE: Energy per resource element (EPRE) of the reference signal (RS), defines
the power of all physical DL channels. The sensitivity level corresponds to the RS EPRE
at which the measured BLER reaches 10%.

T
TA: Test antenna

TBSI: Transport block size index

TDD: Time division duplex (LTE technology)

U
UL: Uplink
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